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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to vali-
date your knowledge of and ability to use programs in the Microsoft Office 2013 suite of 
programs, Microsoft Office 365, and Microsoft SharePoint. This book has been designed 
to guide you in studying the types of tasks you are likely to be required to demonstrate 
in Exam 77-418: Microsoft Word 2013.

See Also For information about the tasks you are likely to be required to demonstrate in 
Exam 77-419: Microsoft Word 2013 Expert, see MOS 2013 Study Guide for Microsoft Word 
Expert by John Pierce (Microsoft Press, 2013).

Who this book is for
MOS 2013 Study Guide for Microsoft Word is designed for experienced computer users 
seeking Microsoft Office Specialist certification in Word 2013.

MOS exams for individual programs are practical rather than theoretical. You must dem-
onstrate that you can complete certain tasks or projects rather than simply answering 
questions about program features. The successful MOS certification candidate will have 
at least six months of experience using all aspects of the application on a regular basis; 
for example, using Word at work or school to create and manage documents, format 
document content, present information in tables and lists, insert and format pictures, 
create business diagrams, and reference sources.

As a certification candidate, you probably have a lot of experience with the program you 
want to become certified in. Many of the procedures described in this book will be famil-
iar to you; others might not be. Read through each study section and ensure that you are 
familiar with not only the procedures included in the section, but also the concepts and 
tools discussed in the review information. In some cases, graphics depict the tools you 
will use to perform procedures related to the skill set. Study the graphics and ensure that 
you are familiar with all the options available for each tool.
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How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate 
to the functional groups covered by the exam, and each chapter is divided into sections 
addressing groups of related skills that correlate to the exam objectives. Each section 
includes review information, generic procedures, and practice tasks you can complete on 
your own while studying. When necessary, we provide practice files you can use to work 
through the practice tasks. You can practice the procedures in this book by using the 
practice files supplied or by using your own files. (If you use your own files, keep in mind 
that functionality in Word 2013 is limited in files created in or saved for earlier versions 
of the program. When you are working in such a file, Compatibility Mode appears in the 
program window title bar.)

Throughout this book, you will find Strategy tips that present information about the 
scope of study that is necessary to ensure that you achieve mastery of a skill set and are 
successful in your certification effort.

Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer. These practice files can be downloaded from 
the following page:

http://aka.ms/mosWord2013/files

Important The Word 2013 program is not available from this website. You should 
purchase and install that program before using this book.

If you would like to be able to refer to the completed versions of practice files at a later 
time, you can save the practice files that you modify while working through the exercises 
in this book. If you save your changes and later want to repeat the exercise, you can 
download the original practice files again.
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The following table lists the practice files for this book.

Folder and functional group Files
MOSWord2013\Objective1
1 Create and manage documents

Word_1-1a.dotx
Word_1-1b.txt
Word_1-1c.pdf
Word_1-2.docx
Word_1-3a.docx
Word_1-3b.docx
Word_1-4a.docx
Word_1-4b.docx
Word_1-4c.docx
Word_1-5a.docx
Word_1-5b.docx
Word_1-5c.docx

MOSWord2013\Objective2
2 Format text, paragraphs, and sections

Word_2-1a.docx 
Word_2-1b.pptx
Word_2-1c.docx
Word_2-2.docx
Word_2-3.docx

MOSWord2013\Objective3
3 Create tables and lists

Word_3-1.docx
Word_3-2a.docx
Word_3-2b.docx
Word_3-3.docx

MOSWord2013\Objective4
4 Apply references

Word_4-1.docx
Word_4-2.docx

MOSWord2013\Objective5
5 Insert and format objects

Word_5-1.docx
Word_5-2.docx
Word_5-3a.docx
Word_5-3b.jpg
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Adapting exercise steps

The screen images shown in this book were captured at a screen resolution of 
1024 × 768, at 100 percent magnification. If your settings are different, the rib-
bon on your screen might not look the same as the one shown in this book. For 
example, you might have more or fewer buttons in each of the groups, the buttons 
you have might be represented by larger or smaller icons than those shown, or the 
group might be represented by a button that you click to display the group’s com-
mands. As a result, exercise instructions that involve the ribbon might require a 
little adaptation. Our instructions use this format:

➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list or on a menu, our instructions use this format:

➜ On the Home tab, in the Editing group, click the Find arrow and then, on the 
Find menu, click Advanced Find.

Tip On subsequent instances of instructions located on the same tab or in 
the same group, the instructions are simplified to reflect that we’ve already 
established the working location.

If differences between your display settings and ours cause a button to appear 
differently on your screen than it does in this book, you can easily adapt the steps 
to locate the command. First click the specified tab, and then locate the specified 
group. If a group has been collapsed into a group list or under a group button, 
click the list or button to display the group’s commands. If you can’t immediately 
identify the button you want, point to likely candidates to display their names in 
ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while 
you read and work through the exercises in this book.

In this book, we provide instructions based on the traditional keyboard and mouse 
input methods. If you’re using the program on a touch-enabled device, you might 
be giving commands by tapping with a stylus or your finger. If so, substitute a tap-
ping action any time we instruct you to click a user interface element. Also note 
that when we tell you to enter information, you can do so by typing on a keyboard, 
tapping an on-screen keyboard, or even speaking aloud, depending on your com-
puter setup and your personal preferences.
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Get support and give feedback
The following sections provide information about getting help with this book and 
 contacting us to provide feedback or report errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our 
Microsoft Press site:

http://aka.ms/mosWord2013/errata

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, email Microsoft Press Book Support at:

mspinput@microsoft.com

Please note that product support for Microsoft software is not offered through the 
 preceding addresses.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
 valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey
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The survey is short, and we read every one of your comments and ideas. Thanks in 
 advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

http://twitter.com/MicrosoftPress
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Taking a Microsoft Office 
Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. When 
screening, hiring, and training employees, employers can feel reassured by relying on the 
objectivity and consistency of technology certification to ensure the competence of their 
workforce. As an employee or job seeker, you can use technology certification to prove 
that you already have the skills you need to succeed, saving current and future employ-
ers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist employees in validating their 
skills with Office programs. The following certification paths are available:

l A Microsoft Office Specialist (MOS) is an individual who has demonstrated profi-
ciency by passing a certification exam in one or more Office programs, including 
Microsoft Word, Excel, PowerPoint, Outlook, Access, OneNote, or SharePoint.

l A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken 
his or her knowledge of Office to the next level and has demonstrated by passing 
a certification exam that he or she has mastered the more advanced features of 
Word or Excel.

Selecting a certification path
When deciding which certifications you would like to pursue, you should assess the 
following:

l The program and program version(s) with which you are familiar

l The length of time you have used the program and how frequently you use it

l Whether you have had formal or informal training in the use of that program

l Whether you use most or all of the available program features

l Whether you are considered a go-to resource by business associates, friends, and 
family members who have difficulty with the program
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Candidates for MOS-level certification are expected to successfully complete a wide 
range of standard business tasks, such as formatting a document or worksheet and its 
content; creating and formatting visual content; or working with SharePoint lists, librar-
ies, Web Parts, and dashboards. Successful candidates generally have six or more months 
of experience with the specific Office program, including either formal, instructor-led 
training or self-study using MOS-approved books, guides, or interactive computer-based 
materials.

Candidates for MOS Expert–level certification are expected to successfully complete 
more complex tasks that involve using the advanced functionality of the program. 
Successful candidates generally have at least six months, and may have several years, 
of experience with the programs, including formal, instructor-led training or self-study 
using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred to 
as the objective domain) that are derived from studies of how the Office programs are 
used in the workplace. Because these skill standards dictate the scope of each exam, they 
provide critical information about how to prepare for certification. This book follows 
the structure of the published exam objectives; see “How this book is organized” in the 
Introduction for more information.

The MOS certification exams are performance based and require you to complete busi-
ness-related tasks or projects in the program for which you are seeking certification. For 
example, you might be presented with a file and told to do something specific with it, or 
presented with a sample document and told to create it by using resources provided for 
that purpose. Your score on the exam reflects how well you perform the requested tasks 
or complete the project within the allotted time.

Here is some helpful information about taking the exam:

l Keep track of the time. Your exam time does not officially begin until after you 
finish reading the instructions provided at the beginning of the exam. During the 
exam, the amount of time remaining is shown at the bottom of the exam interface. 
You can’t pause the exam after you start it.

l Pace yourself. At the beginning of the exam, you will receive information about the 
questions or projects that are included in the exam. Some questions will require 
that you complete more than one task. Each project will require that you complete 
multiple tasks. During the exam, the amount of time remaining to complete the 
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questions or project, and the number of completed and remaining questions if 
 applicable, is shown at the bottom of the exam interface.

l Read the exam instructions carefully before beginning. Follow all the instructions 
provided completely and accurately.

l Enter requested information as it appears in the instructions, but without duplicat-
ing the formatting unless you are specifically instructed to do so. For example, the 
text and values you are asked to enter might appear in the instructions in bold 
and underlined text, but you should enter the information without applying these 
formats.

l Close all dialog boxes before proceeding to the next exam question unless you are 
specifically instructed not to do so.

l Don’t close task panes before proceeding to the next exam question unless you are 
specifically instructed to do so.

l If you are asked to print a document, worksheet, chart, report, or slide, perform the 
task, but be aware that nothing will actually be printed.

l When performing tasks to complete a project-based exam, save your work 
frequently.

l Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on 
its result, not on the method you use to achieve that result (unless a specific method 
is indicated in the instructions).

l If a computer problem occurs during the exam (for example, if the exam does not 
respond or the mouse no longer functions) or if a power outage occurs, contact a 
testing center administrator immediately. The administrator will restart the com-
puter and return the exam to the point where the interruption occurred, with your 
score intact.

Strategy This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Strategy paragraphs such as this one.

Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. If your score meets or exceeds the passing standard (the minimum 
required score), you will be contacted by email by the Microsoft Certification Program 
team. The email message you receive will include your Microsoft Certification ID and 
links to online resources, including the Microsoft Certified Professional site. On this site, 
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you can download or order a printed certificate, create a virtual business card, order an 
ID card, view and share your certification transcript, access the Logo Builder, and access 
other useful and interesting resources, including special offers from Microsoft and affili-
ated companies.

Depending on the level of certification you achieve, you will qualify to display one of 
three logos on your business card and other personal promotional materials. These logos 
attest to the fact that you are proficient in the applications or cross-application skills neces-
sary to achieve the certification.

Using the Logo Builder, you can create a personalized certification logo that includes 
the MOS logo and the specific programs in which you have achieved certification. If you 
achieve MOS certification in multiple programs, you can include multiple certifications in 
one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware, visit:

http://www.microsoft.com/learning/en/us/mos-certification.aspx
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 3 Create tables  
  and lists
The skills tested in this section of the Microsoft Office Specialist exam for Microsoft 
Word 2013 relate to creating and modifying tables and lists. Specifically, the following 
objectives are associated with this set of skills:

3.1 Create tables
3.2 Modify tables
3.3 Create and modify lists

Some types of document content are easier to read when presented in a structured for-
mat; specifically, in a table or list. Tables are particularly useful for presenting numeric 
data, but also for organizing text. Numbered lists are an effective means of presenting 
information that has a specific order or for which you want to designate labels. Bulleted 
lists present unordered sets of information in a tidy format that is far more legible than 
running the information together in a long paragraph.

This chapter guides you in studying ways of creating, modifying, and formatting tables, 
bulleted lists, and numbered lists; sorting table data; and performing calculations in tables.

Practice Files To complete the practice tasks in this chapter, you need the practice files 
contained in the MOSWord2013\Objective3 practice file folder. For more information, see 
“Download the practice files” in this book’s Introduction.

3.1 Create tables
Creating basic tables
Numeric data can often be presented more efficiently in a table than in a paragraph of 
text. Tables present large amounts of data, or complex data, in a format that is easier to 
read and understand by structuring it in rows and columns. Tables frequently include 
row and column headers to explain the purpose or meaning of the data.
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You can create a table in several ways:

l Select the number of rows and columns you want from a grid. Clicking a cell in the 
grid inserts an empty table the width of the text column. The table has the number 
of rows and columns you indicated in the grid, with all the rows one line high and 
all the columns of equal width.

l Specify the number of columns and rows, and the width of the table and its columns, 
in the Insert Table dialog box.

l Manually draw a table that contains rows and columns of the size you want. The 
cells you draw connect by snapping to a grid, but you have some control over the 
size and spacing of the rows and columns. After drawing a table, you can erase 
parts of it that you don't want and adjust the table, column, and row size by using 
tools on the Layout tool tab for tables.

Tip When drawing a table, you can display the rulers or gridlines to help guide you in 
placing the lines.

l Convert selected text to a table of a specified or relative width.

Strategy You can also insert existing data from a Microsoft Excel worksheet in a Word 
document, but the intricacies of using the Microsoft Office programs together are not 
likely to be tested on the Word certification exam.
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A table appears in the document as a set of cells, usually delineated by borders or grid-
lines. (In some Quick Tables, borders and gridlines are turned off.) Each cell contains an 
end-of-cell marker, and each row ends with an end-of-row marker. 

Tip Two separate elements in Word 2013 are named gridlines, and both can be used 
in association with tables. From the Show group on the View tab, you can display the 
document gridlines with which you can position content on the page. From the Table 
group on the Layout tool tab, you can display the table gridlines that define the cells 
of a table.

When you point to a table, a move handle appears in its upper-left corner and a size 
handle in its lower-right corner. When the cursor is in a table, two Table Tools tabs—
Design and Layout—appear on the ribbon.

Tip The end-of-cell markers and end-of-row markers are identical in appearance, and are 
visible only when you display formatting marks in the document. The move handle and 
size handle appear only in Print Layout view and Web Layout view.

Converting between text and tables
Converting text to a table is particularly easy when the text has a consistent structure, 
such as that of a tabbed list. You can convert cell entries that are separated by tabs, com-
mas, paragraph marks, or another single character. Similarly, you can convert any table 
to text that is separated by the same selection of characters.
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Setting AutoFit options
In the Insert Table or Convert Text To Table dialog box, or from the Layout tool tab at 
any time after creating a table, you can specify an exact or relative table width by select-
ing an AutoFit Behavior option. The default AutoFit behavior is Fixed Column Width: 
Auto, which divides the available page width into equal columns. Other AutoFit Behavior 
options include:

l Fixed Column Width with a dimension, which creates columns of the specified 
width.

l AutoFit To Contents, which creates columns only as wide as they need to be to 
 contain their content.

l AutoFit To Window, which sets the table width to the page width and creates equal 
columns or, when applied to a table that has columns of relative width, maintains 
the relation.

Nesting multiple tables
Most people are accustomed to thinking of a table as a means of displaying data in a 
quick, easy-to-grasp format. But tables can also serve to organize your pages in creative 
ways. For example, suppose you want to display two tables side by side. The simplest way 
to do this is to first create a table with one tall row and two wide columns and no grid-
lines. You can then insert one table in the first cell and the other table in the second cell. 
These nested tables then seem to be arranged side by side.
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As with regular tables, you can create a nested table from scratch, by formatting existing 
information, or by inserting Excel data, and you can format a nested table either manu-
ally or by using one of the ready-made table styles.

Tip You can use nested tables to organize a mixture of elements such as text, tables, 
charts, and diagrams.

➤ To insert a table

 1. On the Insert tab, in the Tables group, click the Table button.

 2. In the grid, move the pointer across and down to select the number of columns 
and rows you want, and then click the lower-right cell in the selection.

Or

 1. On the Insert tab, in the Tables group, click the Table button, and then click Insert 
Table.

 2. In the Insert Table dialog box, in the Table size area, specify the number of columns 
and rows you want the table to include.

 3. In the AutoFit behavior area, do one of the following, and then click OK:

❍ Click Fixed column width, and then specify a standard width for the table 
columns.

❍ Click AutoFit to contents to size the table columns to fit their contents. The 
width of the resulting table can be less than the width of the page.

❍ Click AutoFit to window to create a table that fits within the page margins 
and is divided into columns of equal size.
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➤ To draw a table

 1. On the Insert tab, in the Tables group, click the Table button, and then click Draw 
Table.

 2. When the pointer changes to a pencil, drag across and down in the document to 
define the outer edges of the table or an individual column, row, or cell.

 3. Drag to create additional cells, or draw column and row boundaries inside the 
first cell.

 4. Press Esc to turn off the table-drawing pointer.

Tip You can add and remove lines from an existing table by using the Draw Table and 
Eraser commands in the Draw Borders group on the Layout tool tab. You can change 
the style, weight, and color of the borders of drawn tables by setting the options in the 
Borders group on the Design tool tab and then using the Border Painter command.

➤ To convert selected text to a table

 1. Select the text that you want to convert to a table.

 2. On the Insert tab, in the Tables group, click the Table button, and then click 
Convert Text to Table.

 3. In the Convert Text to Table dialog box, adjust the Table size and AutoFit behavior 
settings, select the type of text separator, and then click OK.

➤ To convert a table to text

 1. Click anywhere in the table. 

 2. On the Layout tool tab, in the Data group, click the Convert to Text button.

 3. In the Convert Table to Text dialog box, do one of the following, and then 
click OK:

❍ Click Paragraph marks, Tabs, or Commas to separate the content of table 
cells with one of these standard elements.

❍ Click Other, and then enter any single character in the Other box to separate 
the content of table cells with that character.
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Inserting preformatted tables
In addition to blank tables and tables converted from text, you can create Quick Tables, 
which are preformatted tables containing sample data. You can replace the sample data 
with your own and modify the formatting as you would with any other table.

Built-in Quick Tables include a variety of calendars, simple tables, tables with subhead-
ings, and tabbed lists. Some of the tables present fictitious data for the purpose of 
 illustrating the table layout.

Tip The calendar content of a Quick Table cannot be programmatically set to a specific 
month and year; that information must be replaced manually. You can create calendars 
specific to a calendar year or academic year by selecting a calendar template from the 
New page of the Backstage view.

Strategy  You can save your own custom tables (including content) to the Quick Tables 
gallery so that you can easily insert a frequently used table structure and data into 
any document. The objective domain for Exam 77-418 includes coverage of inserting 
preformatted tables. Saving custom building blocks, including Quick Tables, is part of the 
objective domain for Exam 77-419, Word 2013 Expert.
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Practice tasks

The practice file for these tasks is located in the MOSWord2013\Objective3 practice 
file folder. Save the results of the tasks in the same folder.

l In a new document, create the following tables, separated by page breaks:

❍ Create a table that is three columns wide and four rows high. Ensure 
that each column is exactly 1.5” wide.

❍ Create a table that is five columns wide and six rows high. Ensure that 
the table is the same width as the page, and the columns are of equal 
width.

❍ Create a Matrix Quick Table.

❍ Draw a table that is approximately half the width and one-quarter the 
height of the page. Divide the table into four columns and six rows.

l In the Word_3-1 document, convert the tabbed list that follows the 
Consultation Fee Schedule heading into a table with two columns and four 
rows. Ensure that each column is only as wide as its content. Then convert the 
information that follows the In-Home Trip Charge heading into a page-width 
table with two columns and six rows.

3.2 Modify tables

Formatting tables
To quickly and professionally format a table, you can apply one of the built-in table 
styles. These include a variety of borders, shading choices, text colors, and other at-
tributes to give the table a professional look. When formatting a table, you can choose 
the table elements that you want to emphasize, such as a header or total row or the first 
or last column, and you can format the table with banded columns or rows to make the 
contents more legible.

Tip When the edges of table cells are not visually differentiated by borders or other 
formatting, you can display nonprinting gridlines that define the edges of the table cells.
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➤ To apply a built-in table style

 1. Click anywhere in the table you want to format.

 2. On the Design tool tab, in the Table Styles gallery, click the built-in style you want 
to apply.

➤ To emphasize table elements

➜ On the Design tool tab, in the Table Style Options group, select the check boxes of 
the table elements you want to emphasize.
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➤ To manually format table elements

➜ To shade cells, columns, or rows, select the element and then on the Design 
tool tab, in the Table Styles group, click the Shading arrow and select the color 
you want.

➜ To change the color or width of borders, on the Design tool tab, in the Borders 
group, select the border style, line style, line weight, and pen color you want, and 
then do one of the following:

❍ On the Borders menu, click the border configuration that you want to insert 
with the selected settings.

❍ Click the Border Painter button, and then click individual table borders to 
 apply the selected settings.

➜ To remove selected cell borders, do one of the following:

❍ Select one or more cells, rows, or columns from which you want to remove 
the borders. Then on the Design tool tab, in the Borders group, on the 
Borders menu, click No Border.

❍ On the Layout tool tab, in the Draw group, click the Eraser button, and then 
click individual table borders to remove them. Click the Eraser button again, 
press Esc, or click away from the table to turn off the feature.

➤ To display or hide table gridlines

➜ On the Layout tool tab, in the Table group, click the View Gridlines button.

➤ To format text in tables

➜ Select the text and format it as you would regular text, by clicking buttons on 
the Mini Toolbar and in the Font, Paragraph, and Quick Styles groups on the 
Home tab.

Modifying table data
After creating a table, you can enter text, numbers, and graphics into its cells. You can 
edit the information as you would normal text.
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Sorting table data
You can sort the data within a table by the contents of one or more table columns. Word 
sorts only the data rows in your table, and not the header row (if you indicate in the Sort 
dialog box that the table has one) or the Total row (if you format a Total row in the Table 
Style Options group).

Strategy Create a table that contains multiple columns and many rows of data and 
observe the effect of sorting the table by various columns, with and without a header 
row, and with and without a Total row, to understand the sorting process.

➤ To sort table data

 1. Click anywhere in the table.

 2. On the Layout tool tab, in the Data group, click the Sort button.

 3. In the Sort dialog box, do the following, and then click OK:

 a. In the Sort by area, select the primary column by which you want to sort the 
content, the content type (Text, Number, or Date) if necessary to set the cor-
rect numeric sorting order, and Ascending or Descending.

 b. In the Then by area, select and configure up to two additional nested sorting 
criteria.
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Using formulas in tables
When you want to perform a calculation on numbers in a Word table, you can construct 
a formula by using the tools in the Formula dialog box. In Word 2013 tables, you can 
create formulas that use the following functions:

l ABS() Returns the absolute (positive) value of the specified cell value

l AND() Returns the value TRUE if all arguments in the formula are true

l AVERAGE() Returns the average value of the specified cell values

l COUNT() Returns the number of cells in the specified cell range

l DEFINED() Evaluates an argument specified in the formula and returns 1 if the 
 argument has been defined and 0 if it has not been defined or returns an error

l FALSE() Returns the alternative output value FALSE

l IF() Evaluates a condition specified in the formula and returns one value if the 
 condition is true and another value if the condition is false

l INT() Rounds a number down to the nearest whole number

l MAX() Returns the maximum value in the specified cell range

l MIN() Returns the minimum value in the specified cell range

l MOD() Returns the remainder of a division operation

l NOT() Returns the opposite of a given or calculated TRUE or FALSE value

l OR() Returns one of two values based on criteria specified in the formula

l PRODUCT() Returns the product (by multiplication) of the specified cell values

l ROUND() Rounds a number to the specified number of digits

l SIGN() Returns the value 1 if a number is positive, 0 if the number is zero, or -1 
if the number is negative

l SUM() Returns the sum (by addition) of the specified cell values

l TRUE() Returns the alternative output value TRUE
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A formula consists of an equal sign (=), followed by a function name, followed by a rela-
tive or absolute reference to the cells on which you want to perform the calculation. 
You can reference the cells as ABOVE, BELOW, RIGHT, or LEFT, or use the cell address or 
range. The cell address is a combination of the column letter and the row number—for 
example, A1. Multiple contiguous cells can be addressed as a range consisting of the 
upper-left cell and the lower-right cell separated by a colon, such as A1:B4.

If you change a value that is used in a formula, you must recalculate the formula.

➤ To total a column of values in a table

 1. Click the cell in the table where you want the total to appear.

 2. On the Layout tool tab, in the Data group, click the Formula button.

 3. Enter the formula you want to use in the Formula box.

Or

In the Paste function list, select the function you want to insert. Then enter the cell 
reference in parentheses and any arguments or values required by the formula.

 4. In the Number format list, click the output format for the value to append the 
 correct code for that format to the Formula box.

 5. In the Formula dialog box, click OK.

➤ To view and modify table formulas

➜ To display the field codes of a formula rather than its value, right-click the value, 
and then click Toggle Field Codes.

➜ To manually recalculate a formula value, right-click the value, and then click Update 
Field.

➜ To modify an existing formula, click the formula value, and then on the Layout tool 
tab, in the Data group, click the Formula button.
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Modifying table structure
You can modify a table’s structure at any time. The basic ways to do so are as follows:

l Change the height or width of the table, columns, or rows.

l Insert or delete rows, columns, or cells.

l Merge multiple cells into one cell or split one cell into multiple cells.

l Modify the alignment and spacing within cells.

➤ To select table elements

➜ Click anywhere in the table, column, row, or cell you want to select. On the Layout 
tool tab, in the Table group, on the Select menu, click Select Cell, Select Column, 
Select Row, or Select Table.

➜ To select a table, point to the table, and then click the move handle that appears 
outside its upper-left corner.

Tip You can move a table by pointing to it and then dragging the handle that appears 
in its upper-left corner. Or click the handle to select the table, and then use the Cut 
and Paste commands.

➜ To select a row, point to the left border of the row. When the pointer changes to a 
white, right-pointing arrow, click once.

➜ To select a column, point to the top border of the column. When the pointer 
changes to a black, down-pointing arrow, click once.

➜ To select a cell, triple-click the cell or click its left border.

➜ To select adjacent cells, click the first cell, hold down the Shift key, and then press 
the arrow keys.
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➤ To display the Table Properties dialog box

➜ Right-click anywhere in the table, and then click Table Properties.

Or

 1. Click anywhere in the table or select any table element.

 2. On the Layout tool tab, in the Table group, click the Properties button.

➤ To modify properties from the Table Properties dialog box

➜ On the Table page, set the table width, specify the way the table interacts with the 
surrounding text, and access border and shading options, including the internal 
margins of table cells.

➜ On the Row page, set the height of the selected rows, whether rows can break across 
pages (in the event that the table is wider than the page), and whether the header 
row is repeated at the top of each page when a table is longer than one page.

Tip The Repeat As Header Row option applies to the entire table. The option is 
availa ble only when the cursor is in the top row of the table. Selecting this option 
helps readers of a document to more easily interpret data in multipage tables. It 
also allows assistive devices such as screen readers to correctly interpret the table 
contents.

➜ On the Column page, set the preferred width of the selected column or columns.

➜ On the Cell page, set the width of selected cells and the vertical alignment of text 
within them. Click the Options button on this page to set the internal margins and 
text wrapping of individual cells.

➤ To change the size of a selected table

➜ Drag the size handle in the lower-right corner of the table. If you want to maintain 
the original aspect ratio of the table, hold down the Shift key while dragging the 
size handle.

➜ On the Table page of the Table Properties dialog box, specify the table width in 
inches or percentage of the available page width, and then click OK.

Tip In this book, we specify measurements in inches. You can alternatively use your 
regional unit of measurement.
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➤ To change the height of a selected row

➜ Drag the row’s bottom border up or down.

➜ Drag the row’s Adjust Table Row marker on the vertical ruler up or down.

➜ On the Layout tool tab, in the Cell Size group, change the Table Row Height 
setting.

➜ On the Row page of the Table Properties dialog box, specify the exact or minimum 
row height, and then click OK.

Tip Setting a minimum row height enables the row height to increase when the 
height of cell content exceeds that measurement. You can set the row height in units 
such as pixels (px), but Word converts the measurement to inches when you save the 
changes.

➜ With multiple rows selected, click the Distribute Rows button in the Cell Size 
group on the Layout tool tab, or right-click the selection and then click Distribute 
Rows Evenly.

➤ To change the width of a selected column

➜ Double-click the column’s right border to set it to the narrowest width that fits its 
content.

➜ Drag the column’s right border to the left or right.

➜ Drag the column’s Move Table Column marker on the horizontal ruler to the left or 
right.

➜ On the Layout tool tab, in the Cell Size group, change the Table Column Width 
setting.

➜ On the Column page of the Table Properties dialog box, specify the column width 
in inches or percentage of the table width, and then click OK.

➜ With multiple columns selected, click the Distribute Columns button in the Cell 
Size group on the Layout tool tab, or right-click the selection and then click 
Distribute Columns Evenly.

➤ To insert rows or columns

➜ Point to the left edge of the table, between two rows where you want to insert 
another, or to the top of the table between two columns where you want to 
insert another. A gray insertion indicator labeled with a plus sign appears as you 
approach a possible insertion point (after any existing row or column). When the 
insertion indicator turns blue, click to insert the row or column where indicated.
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➜ Position the cursor in the last cell of a table, and then press Tab to extend the table 
by one row.

Or

 1. Click anywhere in a column or row adjacent to which you want to add a single  
column or row, or select the number of columns or rows you want to insert.

 2. On the Layout tool tab, in the Rows & Columns group, click Insert Above, Insert 
Below, Insert Left, or Insert Right.

Or

On the Mini Toolbar, click the Insert button, and then click Insert Above, Insert 
Below, Insert Left, or Insert Right.

➤ To insert cells

 1. Click the cell adjacent to which you want to add a single cell, or select the number 
of cells you want to insert.

 2. On the Layout tool tab, click the Rows & Columns dialog box launcher.

 3. In the Insert Cells dialog box, specify how adjacent cells should be moved to 
 accommodate the new cell or cells, and then click OK.

➤ To delete a table, rows, or columns

 1. Click anywhere in the table, row, or column you want to delete, or select the rows 
or columns you want to delete.

 2. On the Layout tool tab, in the Rows & Columns group, on the Delete menu, click 
Delete Rows, Delete Columns, or Delete Table.

Or

On the Mini Toolbar, on the Delete menu, click Delete Rows, Delete Columns, or 
Delete Table.

➤ To delete cells

 1. Click the cell, or select the cells you want to delete.

 2. On the Layout tool tab, in the Rows & Columns group, click the Delete button, 
and then click Delete Cells.

Or

On the Mini Toolbar, click the Delete button, and then click Delete Cells.

 3. In the Delete Cells dialog box, specify how adjacent cells should move to replace 
the deleted cell or cells, and then click OK.



108  Chapter 3 Create tables and lists

➤ To create cells that span multiple rows or columns

➜ Select the adjacent cells you want to connect. Then on the Layout tool tab, in the 
Merge group, click the Merge Cells button.

➤ To divide a selected cell into multiple cells

 1. On the Layout tool tab, in the Merge group, click the Split Cells button.

 2. In the Split Cells dialog box, specify the number of columns and rows into which 
you want to divide the cell, and then click OK.

➤	 To	configure	the	alignment	and	margins	of	a	selected	cell

➜ On the Layout tool tab, in the Alignment group, click one of the nine Align but-
tons to specify a combination of top, middle, or bottom and left, center, or right 
alignment.

➜ In the Alignment group, click the Cell Margins button. In the Table Options dialog 
box, set the top, bottom, left, and right margins; specify whether to insert space 
between cells and how much space to insert; and specify whether to automatically 
resize cells to fit their contents.

Tip The default cell margins are 0” on the top and bottom and 0.8” on the left and 
right, with no space between cells and automatic resizing permitted.

Practice tasks

The practice files for these tasks are located in the MOSWord2013\Objective3  
practice file folder. Save the results of the tasks in the same folder.

l In the Word_3-2a document, do the following:

❍ In the Sorting section, sort the table in ascending order by State, then 
by City, and then by Last Name.

l In the Word_3-2b document, do the following:

❍ Merge the cells in the first row of the Estimate table. 

❍ Add two rows below the final table row. 

❍ Change the width of the table to 4”.

❍ Set the height of the header row to 0.4”, and then center-align the 
contents.
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3.3 Create and modify lists

Creating bulleted and numbered lists
Lists are paragraphs that start with a character and are formatted with a hanging indent 
so that the characters stand out on the left end of each list item. You can create bulleted, 
numbered, or multilevel lists. You can choose the starting character from a library of 
preselected bullet symbols, numbering patterns, or multilevel combinations, or you can 
create your own.

You can format an existing set of paragraphs as a list or create the list as you enter infor-
mation into the document.

➤ To create a bulleted list

 1. Enter the list items as separate paragraphs, and then select the paragraphs.

 2. On the Home tab, in the Paragraph group, click the Bullets button, or click the 
Bullets arrow and then click the bullet symbol you want to appear before each 
list item.

Or

 1. Enter * (an asterisk) at the beginning of a paragraph, press the Spacebar or the Tab 
key, enter the first list item, and then press Enter.

 2. Enter items and press Enter to add subsequent bulleted items.
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 3. To end the list, do one of the following:

❍ To start the next paragraph at the left margin, press Enter twice.

❍ To indent the next paragraph at the same level as the list, press Enter and 
then press Backspace or click None in the Bullet Library.

Tip If you want to start a paragraph with an asterisk or number but don’t want to format 
the paragraph as a bulleted or numbered list, click the AutoCorrect Options button that 
appears after Word changes the formatting, and then in the list, click the appropriate 
Undo option. You can also click the Undo button on the Quick Access Toolbar.

➤ To create a numbered list

➜ Select the paragraphs you want to include in the list. On the Home tab, in the 
Paragraph group, do one of the following:

❍ Click the Numbering button to apply the standard numbered list format.

❍ Click the Numbering arrow and then click the numbering format you want 
the list to follow.

Or

 1. Enter 1. (the number 1 followed by a period) at the beginning of a paragraph, 
press the Spacebar or the Tab key, enter the first list item, and then press Enter.

 2. Enter items and press Enter to add subsequent numbered items.

 3. To end the list, do one of the following:

❍ To start the next paragraph at the left margin, press Enter twice.

❍ To indent the next paragraph at the same level as the list, press Enter and 
then press Backspace or click None in the Numbering Library.

➤ To create a multilevel list

 1. Select the paragraphs you want to include in the list. On the Home tab, in the 
Paragraph group, click the Multilevel list button, and then click the format you 
want the list to follow.

 2. To move a list item to a lower level (indented more) press Tab at the beginning of 
the paragraph. To move a list item to a higher level (indented less) press Shift+Tab 
at the beginning of the paragraph.
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Modifying bulleted and numbered lists
After you create a bulleted or numbered list, you can modify the content and formatting 
of the list items, or even change the list type. You can change the bullet symbols, numeric 
characters, and list item levels, and start or restart list numbering at any value.

➤ To change the level of an active list item

➜ On the Home tab, in the Paragraph group, click the Increase Indent button to 
 demote the item or the Decrease Indent button to promote the item.

➜ On the Home tab, in the Paragraph group, click the Bullets arrow or the Numbers 
arrow, click Change List Level, and then in the Change List Level gallery, click the 
level you want.
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➤ To change the order of list items

➜ To move list items, drag them to the new location or cut and paste them. If neces-
sary, click the Paste Options button and then click the Merge List or Don’t Merge 
List button to insert the list item at the hierarchical level you want.

Tip Word automatically updates numbered list items.

➜ Sort list items into ascending or descending order by clicking the Sort button in the 
Paragraph group on the Home tab.

➤ To change the bullet symbol, numbering style, or multilevel list pattern

➜ Click anywhere in the list you want to format, and then on the Home tab, in the 
Paragraph group, do one of the following:

❍ Click the Bullets arrow, and then click the symbol you want to use.

❍ Click the Numbering arrow, and then click the symbol you want to use.

❍ Click the Multilevel List button, and then click the pattern you want to use.

➤	 To	define	custom	bullets

 1. On the Home tab, in the Paragraph group, click the Bullets arrow, and then click 
Define New Bullet.

 2. In the Define New Bullet dialog box, do one of the following, and then click OK to 
add the bullet to the Bullet Library area of the Bullets menu.

❍ Click the Symbol button. In the Symbol dialog box, locate and click the bullet 
symbol you want to use, and then click OK.

❍ Click the Picture button. In the Picture Bullet dialog box, locate and click the 
bullet graphic you want to use, and then click OK.

❍ If you want to specify a font instead of using the document fonts, click the 
Font button, select the font attributes you want, and then click OK.

❍ In the Alignment list, click Left, Centered, or Right to specify the bullet 
alignment.
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➤	 To	define	a	custom	number	format

 1. On the Home tab, in the Paragraph group, click the Numbering arrow, and then 
click Define New Number Format.

 2. In the Define New Number Format dialog box, do any of the following, and 
then click OK to add the number format to the Numbering Library area of the 
Numbering menu:

❍ In the Number style list, click the numbering style you want to use.

❍ If you want to specify a font instead of using the document fonts, click the 
Font button, select the font attributes you want, and then click OK.

❍ In the Number format box, enter any characters (such as a period or the 
word Level) that you want to insert before or after the number.

❍ In the Alignment list, click Left, Centered, or Right to specify the number 
alignment.

➤	 To	define	a	custom	multilevel	list	pattern

 1. On the Home tab, in the Paragraph group, click the Multilevel List button, and 
then click Define New Multilevel List.

 2. In the Define new Multilevel list dialog box, click the More button to display all 
the list options, if necessary.

 3. In the Click level to modify list, click the list level you want to modify.

 4. If the cursor is currently in a list and you want to format all or part of that list with 
the new definition, click Whole list, This point forward, or Current paragraph in 
the Apply changes to list.

 5. In the Link level to style list, click the style to which you want to assign the level 
you’re defining (for example, if you’re defining a Level 2 bulleted list item, you 
might link it to the List Bullet 2 style).

See Also For information about styles, see section 2.2, “Format text and paragraphs.”

 6. In the Level to show in gallery list, click the number of the first level you want to 
display in the thumbnail on the Multilevel List menu. The selected level becomes 
bold in the preview pane.

Strategy Assigning a name in the ListNum Field List Name box for programmatic use 
is beyond the scope of Exam 77-418.
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 7. In the Number format area, do either of the following:

❍ In the Number style for this level list, click the numbering style or bullet 
symbol you want to use for the list level.

Tip You can define a custom bullet or numbering style by clicking New Picture or New 
Bullet in the list.

❍ If you want to specify a font instead of using the document fonts, click the 
Font button, select the font attributes you want, and then click OK.

 8. If you select a numbering style in the Number style for this level list, you can also 
do the following:

❍ If you want to prepend the number of a previous level to the selected format, 
click that level in the Include level number from list.

❍ If you want to specify a starting number or letter other than the default, enter 
the number or letter in the Start at box.

❍ If you want to ensure that the list numbering does not continue past a spe-
cific style (for example, a heading), select the Restart list after check box, and 
then click the style in the associated list.

❍ If you want to force the use of only Arabic numbers (not Roman numerals), 
select the Legal style numbering check box.

 9. In the Position area, set the number alignment and text indent for the level.

Or

To set an alignment and indent pattern for all levels, click the Set for All Levels 
button. In the Set for All Levels dialog box, specify the character and text indent 
for Level 1, specify the additional indent for subsequent levels, and click OK.

 10. Repeat the preceding process for each level you want to define. Then click OK to 
add the level definition to the Lists Library area of the Multilevel List menu.
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➤ To change list or list item indentation

➜ Drag the indent markers on the horizontal ruler.

Tip You can change both the overall indentation of the list and the relationship of the 
first line to the other lines.

➤ To restart the numbering of a numbered list

➜ Right-click the number of the first list item you want to change, and then click 
Restart at 1.

Or

 1. Position the cursor in the list item from which you want to restart. (Subsequent list 
items will renumber to follow the value you set.)

 2. On the Numbering menu, click Set Numbering Value.

 3. In the Set Numbering Value dialog box, click Start new list, and then click OK.

➤ To continue the numbering of a numbered list

➜ Right-click the number of the first list item you want to change, and then click 
Continue Numbering.

Or

 1. Position the cursor in the first list item you want to change.

 2. On the Numbering menu, click Set Numbering Value.

 3. In the Set Numbering Value dialog box, click Continue from previous list.

 4. If you want to skip over numbered lists that are between the original list and the 
continuation, select the Advance value check box and then, in the Set value to 
box, enter the number you want to assign to the list item.

 5. In the Set Numbering Value dialog box, click OK.
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Practice tasks

The practice file for these tasks is located in the MOSWord2013\Objective3 practice 
file folder. Save the results of the tasks in the same folder.

l In the Word 3-3 document, do the following:

❍ Convert the paragraphs under each bold heading other than The 
Sequence of Events to bulleted lists that use the four-diamond bullet 
character.

❍ Create a custom picture bullet that depicts a clip art image of a hero, 
and apply the bullet to only the list in the section The Hero.

❍ Convert the paragraphs under the heading The Sequence of Events to a 
numbered list with the A. B. C. format. Paste a copy of the numbered list 
below the original, and restart the numbering of that list, using Arabic 
numbers instead of letters.

Objective review
Before finishing this chapter, ensure that you have mastered the following skills:

3.1 Create tables
3.2 Modify tables
3.3 Create and modify lists
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A
absolute positioning

building blocks, 141
objects, 146
shapes, 148

alignment
paragraph, 4
table, 92

appending content, to current document, 64
artistic effects, applying, 156, 157
authors

adding to Author property, 43
removing from Author property, 44

AutoCorrect
adding text shortcuts, 70
inserting text and symbols, 69

AutoFit, setting options, 94

B
backward compatibility, maintaining, 54
bibliographies

converting from fields to text, 125
creating, 122, 125
source placeholders, 124
sources, 124, 125
specifying styles for, 125
updating, 125

bookmarks
creating, 18
inserting, 18
moving, 19

borders
changing in paragraphs, 4
changing in tables, 100
removing, 100

breaking columns manually, 22
breaking lines automatically, 23
brightness, changing in images, 157
building blocks

behavior settings, 140
for cover pages, 136
formatting, 141
for tables of contents, 136
inserting in documents, 141

positioning, 141
resizing, 141
sorting by behavior, 140
structural, 136
for tables of contents, 136
templates, 140

Building Blocks Organizer, 138
bulleted lists, creating, 109
bullets, changing/defining, 112

C
calculations in tables, 102, 103
captioned figures, referencing, 131
captions

inserting, 130
number formats, 129
referencing figures, 131

cells. See table cells
character styles, 81, 83
characters, formatting, 4, 26
citations

See also legal citations
creating bibliographies, 122
creating sources, 124

Clipboard, 4
managing items by using, 63
pane, displaying, 62

color schemes, changing in diagrams, 152
colors, changing in images, 157
column breaks, 22, 81
columns

See also table columns; text columns
aligning gridlines, 92
breaking, 22
changing section widths, 81
displaying content in, 80
displaying lines between, 81
formatting text into, 22

commands
adding to custom groups, 41
for formatting images, 155
managing keyboard shortcuts for, 46
not visible on ribbon, 39
removing from groups, 41

Compatibility Checker, 56

Index



compatibility, maintaining, 54
compressing images, 155
contrasts, changing in images, 157
cover pages

creating by using building blocks, 136
inserting predefined pages, 138
removing predefined pages, 138

cropping images, 155
cursor, moving, 2
custom number formats, defining, 113
cycle diagrams, creating by using SmartArt, 149

D
date and time, inserting current, 72
date, inserting in headers and footers, 30
descriptions, sorting in building blocks, 140
diagrams

applying styles to, 152
changing color schemes of, 152
including pictures, 149
types, 149

displaying or hiding formatting marks, 44
dividing table cells, 108
.docm files, 10
Document Panel, displaying, 44
documents

configuring to print, 50
creating blank, 9
customizing options and views, 34
encrypted/unencrypted, 58
field codes, 72
file types, 10
formatting, 21
gridlines, 93
inserting structural building blocks, 136
navigating through, 2, 12
passwords, 58, 59
printing, 51, 52
properties, 42, 72
running Compatibility Checker, 56
saving, 52, 58
sections, 22, 88
style sets, 26
themes, 24

document templates, 10
custom, 9
Normal, 7

.docx files, 10

.dotm files, 10

.dotx files, 10

drawing
standard shapes, 143
table columns, 96
table rows, 96
tables, 92

drawing canvases, opening, 144

E
endnotes

converting to footnotes, 121
creating, 119
number formats, 120, 121
setting location of, 119

exam prerequisites, 5
extensions. See file name extensions

F
field codes

displaying current, 72
for formulas, 103

fields
converting to text in bibliographies, 125
inserting, 72
manually updating, 72

figure captions
inserting, 130
number formats, 129
referencing figures, 129, 131

figures
captioned, 131. See also legal citations
creating tables of, 132

File Explorer, 8, 11
file formats, alternative, 52, 53
file name extensions

.docm, 10

.docx, 10

.dotm, 10

.dotx, 10

.pdf, 53

.rtf, 53

.txt, 53

.xps, 53
files. See documents
Find And Replace feature, 12
finding

document elements, 19
Go To function, 19
nonspecific text, 66
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special characters, 66
specific objects, 66
specific text, 65, 67
text, 12, 65

footers
activating, 29
deleting, 31
editing, 29
inserting custom content, 29
inserting date and time, 30
inserting in document, 28, 30
inserting preformatted page numbers, 33
modifying standard settings, 30
preformatted, 30

footnotes
converting to endnotes, 121
creating, 119
number formats, 120, 121
setting location of, 119

Format Painter, 75
formatting

characters, 4
clearing styles, 84
endnote and footnote numbers, 120
figure captions, 129
images, 155
note text, 121
page numbers, 33
paragraphs, 4
reference marks, 121
tables, 98
table text, 100
text, 3, 5, 74, 75
text box content, 139
text boxes, 139
text into columns, 81
WordArt object backgrounds, 76

formatting marks, displaying or hiding, 44
formulas, in tables

choosing functions, 102
creating, 103
modifying, 103
recalculating values, 103
viewing field codes, 103

functions, in formulas, 102

G
galleries, resizing, 150
Go To function, using, 19
graphic layouts, SmartArt, 149

gridlines
aligning columns/rows, 92
displaying in documents, 93
displaying in tables, 100
hiding in tables, 98

grids, table, 92
groups

adding commands to custom, 41
adding to tabs, 40
removing commands from custom, 41

H
headers

activating, 29
deleting, 31
editing, 29
inserting, 28, 29, 30, 33
modifying standard settings, 30
preformatted, 30

hidden characters, displaying or hiding, 44
hierarchy diagrams, creating by using 

SmartArt, 149
highlighting, removing from text, 84
hyperlinks

to bookmarks, 17
for email messages, 17
to files, 16
to headings, 17
inserting, 15, 16, 17
modifying, 17
removing, 17
to webpages, 16

hyphenation, 23

I
images

adjusting brightness, colors, and contrast of, 155
applying effects to, 155, 157
applying styles to, 155, 157
arranging on pages, 155
changing shape of, 157
choosing presets, 156
cropping, 155
formatting, 155
inserting, 154, 155
manipulating, 156
positioning, 155
resizing, 155, 157
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indentation
lines, 76
lists, 115
paragraphs, 4, 76, 78, 79

interpreting data in multipage tables, 105

K
keyboard shortcuts, 5

assigning, 46
for commands, 46
managing text by using, 5
moving cursor by using, 2
repeating, 5
for symbols, 48

L
layouts, SmartArt graphics, 149
legal citations

creating tables of authorities, 126, 127
marking, 127

line breaks, automatic, 23
line numbers, inserting and controlling, 23
line spacing, setting, 77
lines, displaying between columns, 81
lines, selecting adjacent text, 3
links, updating, 64
list items

changing indentation, 115
changing order of, 112

lists
bullets, 112
changing levels of, 111
continuing numbering of, 115
creating bulleted, 109
creating multilevel, 110
creating numbered, 109, 110
indentation, 115
item order, 112
list item markers, 115
multilevel list patterns, 112, 113
number formats, 112, 113
numbering styles, 112
patterns, 112
restarting numbering, 115
starting new, 115

locating. See finding

M
macro-enabled document templates, 10
macro-enabled documents, 10
macros

enabling, 48
managing security, 48
modifying, 46
recording, 44, 45

magnification levels
changing, 35
Zoom group, 35
zooming to a program window, 36

manual column breaks, 81
manual page breaks, 86
manual section breaks, 88
margins. See page margins
matrix diagrams, creating by using SmartArt, 149
Microsoft Office Clipboard. See Clipboard
Microsoft SkyDrive. See SkyDrive
Microsoft Word documents. See documents
move handles, appearance of, 93
moving between specific locations and 

elements, 19
multilevel lists

creating, 110
patterns, 112, 113

multiple shapes, stacking, 148

N
names, of building blocks, 140
navigating in documents, 2
Navigation pane, searching from, 12, 14
nesting multiple tables, 94
nonbreaking spaces, inserting, 23
non-native files, opening, 9, 11
nonprinting gridlines, displaying, 98
Normal template, style definitions, 26
note text, formatting manually, 121
numbered lists

creating, 109, 110
restarting numbering, 115
setting numbers, 115

number formats
captions, 129
defining, 113
in endnotes and footnotes, 120, 121

Numbering Library, adding number  
formats to, 113
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O
objects

arranging on pages, 146
positioning, 146
stacking, 147
text wrapping options, 145

Office 365 SharePoint sites, adding to Save As 
locations, 57

online images, inserting, 155

P
page breaks

controlling, 88
forcing, 86
inserting, 86
removing, 86

page margins, changing, 21
page numbers

changing formats, 33
inserting, 29, 32, 33

pages
arranging objects on, 146
inserting manual page breaks, 22
managing page breaks, 86
managing paragraph breaks, 87

panes
Clipboard, 62
Navigation, 12, 14
Selection, 146, 148
Styles, 26, 83

paper sources, specifying, 52
paragraphs. See also text

alignment, 4
applying styles, 81
borders, 4
formatting, 4, 26
indentation, 4, 76, 78
managing breaks, 87, 88
selecting, 3
shading, 4
spacing, 4, 77, 78, 79

passwords
protecting documents by using, 58
removing, 59, 60

paste options, 5
pasting content, 63, 64
PDF (.pdf) files

format, 53
saving as, 54

pictures
applying effects to, 157
including in SmartArt graphics, 149

placeholders. See source placeholders
plain text (.txt) files, 53
Portable Document Format. See PDF
positioning

building blocks, 141
images, 155
objects, 146
shapes, 142, 148

predefined pages, inserting/removing, 138
preformatted image effects, 156
preformatted image styles, 155
preformatted page numbers, 33
preformatted tables, 97
prerequisites, exam, 5
printing documents

configuring, 50
double-sided, 52
multiple copies of, 51
multiple pages per sheet, 52
portions of, 51
scaling pages, 52
selecting printers, 50

process diagrams, creating by using SmartArt, 149
properties

adding authors to the Author property, 43
displaying for tables, 105
inserting dynamic document properties, 72
setting or changing the Comments, Tags, or Title 

properties, 43
pyramid diagrams, creating by using SmartArt, 149

Q
Quick Access Toolbar

adding/removing commands, 38
moving, 37
organizing commands on, 38
resetting, 37
for a specific document, 38

Quick Tables
built-in options, 97
creating, 97
displaying/hiding borders, 93
displaying/hiding gridlines, 93
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R
reference marks, formatting manually, 121
reference sources, 124
reference styles, 124
relationship diagrams, creating by using 

SmartArt, 149
relative positioning

building blocks, 141
objects, 146
shapes, 148

remote locations, saving files in, 57
replacing text, 65, 67
resizing images, 155, 157
ribbon

customizing, 39
modifying tabs and groups, 40
resetting, 41

Rich Text Format (.rtf) files, 53
rows. See table rows
.rtf (Rich Text Format) files, 53

S
screen readers, 105
searching. See finding
search results, restricting, 66
section breaks, 22, 88, 89
Selection pane

displaying, 148
managing object display, 146

sentences, selecting, 2
shading

paragraphs, 4
table elements, 100
tables, 105

shapes
adding text to, 144
arranging, 144
changing colors, outline, or effects, 151
changing forms of, 143
changing shape of, 144
deleting from SmartArt graphics, 152
drawing, 143
editing, 143
flowing text around, 147
grouping/ungrouping, 144
of images, 156
moving, 143, 144
positioning, 148
resizing, 143

stacking, 148
styles, 143, 151, 152

SharePoint sites, adding to Web Locations list, 57
size handles

appearance of, 93
changing size of selected table, 105

SkyDrive, adding to Save As locations, 57
SmartArt graphics

choosing layouts, 149, 150
creating, 149, 152
deleting shapes from, 152
diagram types, 149
including pictures, 149
selecting built-in templates, 149

sorting table data, 101
source placeholders, 124
sources

citing, 125
creating for bibliography, 124
updating placeholders, 124

spacing, paragraph, 4, 77, 78, 79
special characters

finding, 66
inserting, 69

specific objects, finding, 66
splitting windows, 41, 42
square text wrapping, 146
stacking

objects, 147
shapes, 148

storage locations, for building blocks, 140
styles

See also style sets
for characters, 26, 83
clearing, 84
for diagrams, 152
displaying in Styles pane, 83
for images, 155, 156, 157
for paragraphs, 26, 83
for shapes, 151
specifying in bibliographies, 125
for tables, 95, 99

style sets, 26
applying, 28
resetting to the template default, 28
switching, 27

Styles pane, 26, 83
symbols

assigning keyboard shortcuts, 48
changing bullets, 112
inserting, 68, 69
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T
table cells

borders, 100
configuring alignment, 108
configuring margins, 102
deleting, 104, 107
dividing, 108
inserting, 104, 107
merging, 108
shading, 100
snapping to grids, 92

table columns
banded, 98
changing width of, 106
deleting, 104, 107
inserting, 104, 106
selecting from a grid, 92
shading, 100

table elements, emphasizing, 99
table of authorities, 126, 127
table of contents, 136
table of figures, 132
table rows

aligning to gridlines, 92
changing height, 106
deleting, 104, 107
inserting, 104, 106
selecting from a grid, 92
shading, 100

tables
See also table cells; table columns; table rows
applying styles, 99, 100
borders, 96, 100
calculating values, 102, 103
changing size of, 105
configuring alignment and margins of, 108
converting text to, 93, 96
converting to text, 96
creating, 91, 92, 95, 97
deleting, 107
drawing, 96
emphasizing elements of, 99
formatting, 98, 100
formatting for screen readers, 105
formatting text in, 100
formulas in, 102, 103
gridlines, displaying/hiding, 98, 100
modifying structure of, 104
nesting, 94, 95
preformatted, 97
properties, 105

selecting elements of, 104
shading, 100, 105
sorting data in, 101
specifying width by using AutoFit, 93

tabs, 40
templates

for building blocks, 140
for documents. See document templates

text
adding to shapes, 144
applying styles, 81
AutoCorrect shortcuts, 70
changing direction in text boxes, 139
converting to tables, 93, 96
copying, 5
copying formatting, 75
cutting, 4
deselecting, 3
dragging, 5
finding, 12, 14, 65, 66
flowing around shapes, 147
formatting, 3, 5, 75
formatting into columns, 22
inserting by using AutoCorrect, 69
inserting into text boxes, 139
keyboard shortcuts, 5
pasting, 5, 62
removing highlighting, 84
replacing, 65, 67
selecting, 2, 3

text boxes, 137
accessing online design choices, 137
changing default formatting, 139
changing text direction in, 139
formatting, 139
inserting, 137, 138
inserting predefined styles from gallery, 138
inserting text in, 139

text columns, 81
text wrapping, 145
themes, 24, 25
time, inserting in headers and footers, 30
.txt (plain text) files, 53

U
ungrouping shapes, 144

V
views, customizing document options, 34
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W
watermarks

adding text, 32
inserting, 31
using pictures as, 32

Windows Explorer. See File Explorer
WordArt, 75, 76
words. See text

X
XPS (.xps) files, 53

Z
Zoom group, 35
Zoom slider, 36
zooming, 36
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